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Session 2: Exploring GIS
Map Production - Exploring various GIS functions
Objectives:

1. To create a map layer – Air Pollution Index (API) and its attribute table

2. To symbolize your data  

3. To design a map layout

Task 1: Creating map layer and attribute table

1. Start ArcCatalog
· In Start menu, select ArcCatalog under ArcGIS folder.
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2. Create a new feature layer

· Select the working directory C:\yuikee\SHAPEFILE\
[image: image2.png]GEODATABASE
- & I

St Basear
(] BS000_BASEMAP





· In File menu, select New and then click Shapefile to create new Shapefile.
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· Type “API” as the name of this new Shapefile in Create New Shapefile menu.
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· Select “Point” in the field Feature Type.

· Select OK to finish.

(You may check that a new Shapefile was created under the working directory.)

3. Build an attribute table

· Right click the new Shapefile “API”.
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· Select Properties to open Shapefile Properties menu.
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· Select Fields tab to open field properties menu.

· In the new row, click the empty space under Field Name column.

· Type “Name” and then select Text under Data Type column.
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· Repeat the previous step and then add the new field “API” with data type “Short Integer” and “Address” with data type “Text”.

· Press OK to finish the attribute table creation.

4. Start feature editing – adding, moving and deleting feature

· In ArcCatalog toolbar, click ArcMap button [image: image8.png]


 to start ArcMap.

· Open the existing ArcMap Document Lesson_1.mxd
· Click the Add button in ArcMap and then select API under the working directory C:\yuikee\SHAPEFILE\
· Click Start Editing under the Editing menu in Editor toolbar.

(You may click the Editor button [image: image9.bmp] in Standard toolbar to add Editor toolbar.)

· Highlight the Source where the API layer is stored.
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· Click the Create New Feature button [image: image11.png]


 to add API stations on the map. 
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5. Edit feature attributes

· Right click the API layer in TOC.
· Select Open Attribute Table.
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(To identify the corresponding feature from the map, click the record and then highlight the record. Corresponding feature will be highlighted)

· Type the name of API station to the field “Name” and corresponding API value and address in the field API and Address respectively.

	Attributes of API

	Name
	Id
	API
	Address

	Shum Shui Po
	1
	39
	37A Yen Chow Street

	Kwun Tong
	2
	37
	6 Tung Yan Street

	Eastern
	3
	30
	Sai Wan Ho Fire Station

	Causeway Bay
	4
	56
	1 Yee Wo Street

	Central
	5
	47
	Charter Road

	Central / Western
	6
	31
	1 High Street

	Mong Kok
	7
	48
	Nathan Road
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· Repeat the previous step to complete all records

· Close the attribute table.

6. Save and Exit feature editing

· Click Stop Editing under the Editing menu in Editor toolbar. 

· Press Yes button to save the editing.

Task 2: Setting the style and symbol

1. Select single symbol

· Double click the symbol below the layer API in TOC to open Symbol Selector menu
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· Select “Circle 2” symbol and then change the color to red in Options.
· Press OK to finish.

2. Select different symbol to represent different feature type

· Right click the layer in TOC
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· Select Properties to open Layer Properties menu

· Select Symbology tab

[image: image18.png]Layer Properties.

Show.
Features

Single symbol
Categories

Quantities
Charts

Multiple Attributes

N e

Generol | Sourve | Selection | Display {SJESIS%) Fields | Definition Query | Labels | Joins & Relaes |

Draw all features using the same symbol.

Label appearing next o the symbol in tble of contents:

Symbol

Advanced -

Legend

Description.

‘Additionl deseiption appearing next o the symbol in your map'slegond

i





· Select Categories in Show menu and then highlight Unique Value
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· In Value Field, select ID.
· Press Add All Values to set different symbol for different ID.

· Press OK to finish.

3. Select graduated symbol to represent different value of attribute

· Right click the API layer in TOC.

· Select Properties to open Layer Properties menu.

· Select Symbology tab.

· Select Quantities in Show menu and then highlight Graduated Symbol.
· In Value Field, select API
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(Remark: You may set the classification method to equal interval in Classification dialog box by clicking the button Classify.)

· Press OK to finish
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Task 3: Setting the map layout and printing

1. Set map window to layout view

2. Add map element

[image: image22.png]£5 Data Frame.
g Tite

A Text

@ Neatine
g Leaend

] North Amrow,

e Soale Bar
e Soale Text

@ Rotus.

Object.





· In Insert menu, click the Title to add map title

· Click the Legend to open Legend Wizard
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· Remove all the items in Legend Items except API and then click Next to finish.

· Click the North Arrow to add north symbol. 

· Click the Scale Bar to add scale bar

· Click the Scale Text to add scale text

3. Set map grid

· In map layout view, right click the map layout and then select Properties
· Select Grid tab in Data Frame Properties
· Press New Grid to create new grid

· Select Reference Grid and then press Next to finish
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4. Export the map 

· In File menu, click Export Map
· Enter the filename and set the file to JPEG format

Demonstrations and practice: Applying GIS in teaching S1-S3 curriculum

Brainstorming exercise

The list below is the main themes you may have to teach at Junior Secondary level. For each, try to think about a teaching or learning activity which may make use of GIS:

*For the detailed syllabus, go to Education and Manpower Bureau (www.emb.gov.hk)→English→Kindergarten, Primary and Secondary Education→Curriculum Development→Personal, Social and Humanities Education→Curriculum & Syllabuses→Geography→Geography (Secondary 1-3)
	Theme
	Teaching/Learning Activity

	Secondary 1

	Scramble for land! 

– Urban land use
	

	Fixing our cities’ problems 

– Urban problems
	

	Where are our factories moving to? 

– Industrial location
	

	Moving out or into cities 

– Urbanization and suburbanization
	

	Where to spend our holidays? 

– Recreation and travel
	

	Secondary 2

	Weather and climate – do they matter?
	

	Collapsing slopes!
	

	Too much water! 

– Water cycle and flooding
	

	Taming the spreading deserts 

– Deserts and desertification
	

	The unstable Earth 

– Earthquakes and volcanoes
	

	Farming the wrong way? 

– Agriculture and technology
	

	Too many and too few 

– Population problems
	

	Secondary 3

	Save our rainforests! 

– Natural vegetation
	

	Oceans in trouble 

– Marine resources
	

	How clean is our atmosphere? 

– Air pollution and acid rain
	

	Struggle for power resources
	

	Industrial miracle 

– Industrial development
	

	The rich and the poor

– Development and interdependence
	


Creating your own step-by-step manual

Exercise 1
The map below was worked out by a S2 student. It shows the close relationship between some major earthquakes, including the Kobe earthquake, and the plate boundaries around Japan.
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You may ask your students to produce a similar map, showing Japan, other regions or the world. Work out a detailed step-by-step manual for yourself. You will find it helpful for your students:

1. Switch on your computer.

2. ___________________________________________________________________

3. ___________________________________________________________________

4. ___________________________________________________________________

5. ___________________________________________________________________

6. ___________________________________________________________________

7. ___________________________________________________________________

8. ___________________________________________________________________

9. ___________________________________________________________________

10. __________________________________________________________________

Demonstrations and practice: Applying GIS in teaching CE curriculum

Brainstorming exercise

The list below is the main themes and issues you have to teach at the new CE level. For each, try to think about a teaching or learning activity which may make use of GIS:

*For the detailed syllabus, go to Education and Manpower Bureau (www.emb.gov.hk)→English→Kindergarten, Primary and Secondary Education→Curriculum Development→Personal, Social and Humanities Education→Curriculum & Syllabuses→Geography→S4-5 Geography Curriculum Guide

	Theme/Issue
	Teaching/Learning Activity



	Climate

- Climatic Types
	

	Climatic Anomalies

- Global Warming
	

	Landforms and Endogenetic Processes

- Plate Tectonics
	

	Natural Hazards

- Earthquakes, Volcanoes and Tsunami
	

	Landforms and Exogenetic Processes

- Rivers
	

	The Trouble of Water

Floods and Droughts
	

	Agriculture

-Farming systems
	

	Food and Hunger

- Famines
	

	Industry

- Industrial Location
	

	The Choice of Power

- Energy problem
	

	City

-Urban development
	

	Sustainable City

- Sustainable Development
	


Creating your own step-by-step manual

Exercise 2
At CE level, you may let your students try a more complicated work. Now try to prepare a map showing the close relationship between the location of active volcanoes and the plate boundaries. Work out a detailed step-by-step manual for your students:

1. Switch on your computer.

2. ___________________________________________________________________

3. ___________________________________________________________________

4. ___________________________________________________________________

5. ___________________________________________________________________

6. ___________________________________________________________________

7. ___________________________________________________________________

8. ___________________________________________________________________

9. ___________________________________________________________________

10. __________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

Demonstrations and practice: Applying GIS in teaching AL curriculum

Brainstorming exercise

The list below is the main themes you have to teach at Advanced Level. For each, try to think about a teaching or learning activity which may make use of GIS:

*For the detailed syllabus, go to Education and Manpower Bureau (www.emb.gov.hk)→English→Kindergarten, Primary and Secondary Education→Curriculum Development→Personal, Social and Humanities Education→Curriculum & Syllabuses→Geography→Geography (Advanced Level)

	Theme
	Teaching/Learning Activity

	Natural Landscapes

	Climatic System

	Energy budget & flow

- insolation and temperature
	

	Atmospheric moisture

- condensation and precipitation
	

	Atmospheric circulation

- pressure and wind
	

	Climatic variation

- climatic types
	

	Landform System

	Plate tectonics

-plate movement and tectonic landforms
	

	Drainage basin

- water cycle and basin subsystems
	

	Biotic System

	Ecosystem

- energy flow and nutrient cycles
	

	Soils

-soil forming processes
	

	Vegetation

- plant ecology and natural vegetation
	

	Biomes

- vegetation response to environment
	

	People-environment Relationships

	Tropical rain forest

- deforestation and afforestation
	

	Tropical desert

- human adaptations and desertification
	

	Agricultural Landscapes

	Farming systems

- agroecosystems and farming types
	

	Agricultural location

- von Thünen and Sinclair models
	

	Impact of urbanization and industrialization

- farming changes
	

	Farming hazards

- flooding and droughts
	

	Urban and Industrial Landscapes

	Urban functions and hierarchy

- functions of cities and Christaller model
	

	Urban structure

- urban land use models
	

	Manufacturing location

- Weber model
	

	Urban problems

- housing and transport problems
	

	Environmental impact

- pollution and environmental changes
	


Creating your own step-by-step manual

Exercise 3
Your Advanced Level students should be capable of manipulating data with the GIS. Now try to prepare a map showing the close relationship between the location of most recent major earthquakes and the plate boundaries. Work out a detailed step-by-step manual for your students:

1. Switch on your computer.

2. ___________________________________________________________________

3. ___________________________________________________________________

4. ___________________________________________________________________

5. ___________________________________________________________________

6. ___________________________________________________________________

7. ___________________________________________________________________

8. ___________________________________________________________________

9. ___________________________________________________________________

10. __________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________
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